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HOW TO RAISE AN INVOICE

This section will explain the steps necessary to raise a new invoice and print the invoice.

1) Click the button labeled NEW.

2) You must have a valid customer account number to assign against the invoice.

 Click the button labeled ACCs to display the customer database editor.

 Enter a unique 10 character code and press Return. (This will be know as the Account 
Number.)

 Enter all other required details.

 To save the new customer account Click on the button labeled SAVE.

 To exit the customer database click on the button labeled CANCEL.

3) Enter the Customers Account Number in the box labeled Account No.

4) Enter the other details required on the Invoice.

5) To save the Invoice simply click the button labeled SAVE.

6) To print the invoice simply click the button labeled PRINT, select the number of copies and
click the button labeled OK.

7) You should now have a copy of you invoice on paper and file.



NEW INVOICE

A new invoice will be generated only if the current invoice has been saved. To activate a new
Invoice click the button labeled NEW (as above). 

 This will cause the invoice number to increase by 1
 This will cause the invoice on screen to be cleared

The new invoice will not be saved unless you click the SAVE button or select Save Invoice 
from the File menu

KEY SHORTCUT    = Ctrl + N



SAVE INVOICE

To save an invoice click the button labeled SAVE or select Save Invoice from the File menu

 The Invoice will not be saved unless an Account No has been correctly entered. 
 If the Invoice already exists on file (ie. has been saved before) you will be prompted to 

confirm your SAVE request.

KEY SHORTCUT    = Ctrl + S



LOADING/OPEN EXISTING INVOICE

To load an existing invoice click the button labeled OPEN or select Open existing Invoice from
the File menu.

 If the current invoice has not been saved, you will be prompted as to whether you wish to 
save the invoice.

KEY SHORTCUT    = Ctrl + L



PRINTING INVOICES

To Print an Invoice click the button labeled PRINT or select Print Invoice from the File menu.

1) Enter the number of copies you require

2 )Click the OK button to print, Click the CANCEL button to abort

KEY SHORTCUT    = Ctrl + P



CREATING CUSTOMER ACCOUNTS

All Invoices must be assigned a customer account number. If the customer does not exist it 
will be necessary to create new customer.

1) Click the button labeled ACCs or select Customer Accounts from the Database menu. A 
second window will be displayed allowing you to amend the customer database.

2) Enter a unique customer account number in the box labeled Account No.

3) Enter company name and address.

4) Click on the button labeled SAVE to save the details.

5) Click on the button labeled CANCEL to exit the customer database.

More information on the Customer Database Editor



CUSTOMER DATABASE OPTIONS

Every invoice within the system must have a customer account number. Every customer 
account number within the system must be unique to the customer.

This function is used to create and edit customer accounts. Click the button labeled ACCs or 
select Customer Accounts from the Database menu, a second window will appear allowing 
you to amend the customer database.

PREV previous record
Click this button to move to the previous record in the customer database.

NEW new customer
Click this button to clear the customer entry screen, if the current account has not been 
saved then you will be prompted to save.

LOAD load existing customer
Click this button to load an existing customer. You will be required to enter a valid account 
number and click the OK button to load.

SAVE
Click this button to save the account details to the customer database. If the account 
already exists you will be asked if you wish to continue.

PRINT 



Click this button to print the customer details.

DEL delete customer
Click this button to remove the customer from the database, you will be asked to confirm 
your deletion.

Cancel
Click this button to exit from the customer account database editor.

NEXT next record
Click this button to move to the next customer in the database.



INVOICE PAYMENTS

This function is used to make payments against a customers outstanding account. Payments
are recorded against every individual invoice.

1) Click the button labeled £PAY or select Payments from the Database menu.

2) Enter the Account No of the customer your payment is from and click OK.

3) Enter the cheque number followed by the cheque value.

4) Enter the payment(s) value against the corrosponding Invoice(s).

5) Click the button labeled SAVE to save the details.

6) You will be returned to the main invoice screen 

 Invoice90 will check to ensure that the amount of money received = amount allocated.



Obtaining Technical Support from Micro90

Office : (+44) [0]1 202 667337
Fax : (+44) [0]1 202 665609

Out of Office : (+44) [0]585 172792
Hours : (+44) [0]378 783982

email

Compuserve : 100534,1100
InterNet : micro90@bournemouth-net.co.uk



CALCULATOR

To display the calculator on screen click on the button labeled CALC or select Calculator... 
from the Edit menu.

 The Calculator works much like any other calculator.

 Click the Close button when you have finished with the calculator.

 You may use Drag and Drop methods on the calculator display, simple click and hold the 
mouse button down on the display and drag the mouse pointer to the position on the invoice
you wish the figure to be inserted and release the mouse button.



VAT% RATE DETAILS

To change or setup the standard VAT rate on the system select Edit User Details... from the 
Database menu

 A window will appear with the user details setup on the system. The box    labeled std VAT
% contains the standard vat rate.

 Click the OK button to save the details.

 Click the Cancel button to disregard any changes made.



EDITING USER DETAILS

To change or setup the user details on the system select Edit User Details... from the 
Database menu.

 A window will appear with the user details setup on the system.

Text Description Example Comment
Company 
Name...........

..................................

....
+ Printed on invoice

Address 
1.....................

..................................

....
......................................

Address 
2.....................

..................................

....
......................................

Address 
3.....................

..................................

....
......................................

Address 
4.....................

..................................

....
......................................

Tel.............................
...

..................................

....
......................................

Fax............................
...

..................................

....
......................................

Company Reg 
No.........

389 2832 1234 ......................................

Company VAT 
No.........

123 1234 12 ......................................

Name 
1........................

partner/director name
1

+ Used to display names of

Name 
2........................

partner/director name
2

      partners or directors

Name 
Desc...................

Partners / Directors + Description of names 1 + 2

Comments 
1.................

..................................

....
+ Printed on bottom of

Comments 
2.................

..................................

....
      invoice

std VAT rate
%..............

17.50.........................
....

+ standard VAT rate

TAX/VAT desc VAT% + characters used on 
screen/printer

Currency Char $ + character used on 
screen/printer

 Click on the OK button to save the details.

 Click on the Cancel button to disregard any changes made.



EDITING BANK DETAILS

If you wish to include your bank details on the invoices. Enter you bank details using this 
function.

To change or setup the you bank details on the system select Edit Bank Details... from the 
Database menu.

 A window will appear with your bank details setup on the system.

Text Description Example Comment
Bank 
Name..................

..................................

....
......................................

Address 
1.....................

..................................

....
......................................

Address 
2.....................

..................................

....
......................................

Address 
3.....................

..................................

....
......................................

Address 
4.....................

..................................

....
......................................

Sort 
Code.....................

Sort Code : 10-10-
10.....

Your Banks sort code (prefix)

Account 
No...................

Account No : 
436346445

Your Account No.    (prefix)

( (prefix) you must allow for a description of the following number eg. Account No :    )

 Click the OK button to save the details.

 Click the Cancel button to disregard any changes made.



TEXT DRAG AND DROP

To use the Text insert feature on the invoice click on the button labeled TEXT or select Text 
Drag and Drop from the Databases menu.

 The feature enables you to insert preset lines of text into you invoice very fast . Simply 
click and hold the button down on the text line you wish to insert (Yellow Background), drag 
the mouse pointer to the point on the invoice you wish to insert the text into and release the
mouse button.

 To amend the details on the TEXT feature simple click on the required line and enter the 
new text. Details are automatically saved on exit.

 Always click the Close button when you have finished.



EDITING INVOICE NUMBER

To alter the next invoice number select Edit Invoice No... from the Databases menu.

 Never set the number lower that the last invoice issues !

 Never set the number higher that 30000.

 Click OK to set the invoice number.



YEAR END
Run this option when your tax year in Ends. It wipes old data and compacts the database.

 It will wipe all paid invoices from system.

 It will wipe all records of payments.

 It will Compact the database after all deletions.

 MAKE SURE YOU TAKE BACKUPS !!!!



REPAIRING DATABASE FILES
To repair the main database select Repair Database.. from the Databases menu.

 The system will prompt you to continue, warning that the main database file will need to 
be closed. Select Cancel to exit this feature.

 Repairing the database could take upto 5 minutes depending on database size.



LIST CUSTOMERS REPORT

Select List Customer database... from the Reports menu. This will display a box with various 
criteria setting.

 Press RETURN to accept the user default option from the blue box, otherwise enter the 
criteria manually.

 Click on the OK button to compile the report.

CRITERIA LIST

START CUSTOMER ACCOUNT NO
END CUSTOMER ACCOUNT NO

_________________________________

When the report has complied a report viewing screen will be displayed. Use the sliding bar 
to view the report.

 Click on the button labeled Print to print the report.

 Click on the button lableled Setup to change the printer setup.

 Click on the button labeled Cancel to exit the report viewer.



LIST SALES INVOICES REPORT

Select List Sales Invoices... from the Reports menu, this will display a box with various 
criteria setting.

 Press RETURN to accept the user default option from the blue box, otherwise enter the 
criteria manually.

 Click on the OK button to compile the report .

CRITERIA LIST

START INVOICE NO
END INVOICE NO

________________________________

When the report has complied a report viewing screen will be displayed. Use the sliding bar 
to view the report.

 Click on the button labeled Print to print the report.

 Click on the button lableled Setup to change the printer setup.

 Click on the button labeled Cancel to exit the report viewer.



LIST CHEQUES RECEIVED REPORT

Select List Cheques Received... from the Reports menu, this will display a box with various 
criteria setting.

 Press RETURN to accept the user default option from the blue box , otherwise enter the 
criteria manually

 Click on the OK button to compile the report .

CRITERIA LIST

START DATE
END DATE

_________________________________

When the report has complied a report viewing screen will be displayed. Use the sliding bar 
to view the report.

 Click on the button labeled Print to print the report.

 Click on the button lableled Setup to change the printer setup.

 Click on the button labeled Cancel to exit the report viewer.



LIST OUTSTANDING INVOICES REPORT

Select List Outstanding Invoices... from the Reports menu, this will display a box with various
criteria setting.

 Press RETURN to accept the user default option from the blue box, otherwise enter the 
criteria manually.

 Click on the OK button to compile the report .

CRITERIA LIST

START CUSTOMER ACCOUNT NO
END CUSTOMER ACCOUNT NO
START INVOICE DATE
END INVOICE DATE

_________________________________

When the report has complied a report viewing screen will be displayed. Use the sliding bar 
to view the report.

 Click on the button labeled Print to print the report.

 Click on the button lableled Setup to change the printer setup.

 Click on the button labeled Cancel to exit the report viewer.



Kãtnote K Print Statements;PRINTPRINT STATEMENTS

Select Print Statements... from the Reports menu,    this will display a box with various 
criteria setting.

 Press RETURN to accept the user default option from the blue box, otherwise enter the 
criteria manually.

 Click on the OK button to compile and print the statements.



EXITING INVOICE90

Click on the button labeled EXIT or select Exit from the File menu

 Invoice90 will check to ensure the current invoice has been saved, If not you will prompt 
to confirm you wish to exit.



COPYRIGHT
READ CAREFULLY, USAGE OF THIS SOFTWARE MUST DEPEND ON ACCEPTANCE OF 
THESE TERMS

(c) Invoice90 for Windows(R). Copyright Micro90, 1995.
All rights reserved

SHAREWARE VERSION

Evaluation and Registration

 This in not free software. You are hereby licensed to use this software for evaluation 
purposes without charge for a period of 21days. If you use this software after the 21 day 
evaluation period a registration fee of £24.99 +    (P&P £1.50) + VAT (Total £31.13) is 
required. Payments must be is pounds sterling and should be sent to Micro90, First Floor, 
Hamworthy House, New Quay Road, Poole, Dorset, BH15 4AD, ENGLAND as described in 
Ordering Invoice90

 Unregistered use of Invoice90 for windows after the 21 day evaluation period is in 
violation of International copyright laws.

Distribution

 Provided that you verify that you are distributing the Shareware Version (see front title 
screen for wording Shareware Version) you are hereby licensed to make as many copies of 
the Shareware Version of this software and documentation as you wish; give exact copies of 
original Shareware version to anyone, and distribute the Shareware version of the software 
and documentation in its unmodified form via electronic means. There is no charge for any 
of the above.

 You are specifically prohibited from charging, or requesting donations for any such copies, 
however made, and from distributing the software and/or documentation with other 
products(commercial or otherwise) without prior written permission.

REGISTERED VERSION

 One registered copy of Invoice90 for windows may either be used by a single company or 
individual on a standalone machine.

 Micro90 reserve the copyright of the Invoice90 for windows software which is not to be 
copied , Reproduced or Disclosed to a third party without the prior written consent of 
Micro90.

MICRO90 ACCEPT NO LIABILITY FOR ANY DATA LOSS,CLAIMS,FINES OR ANY OTHER KIND OF 
PENALTY INCURRED BY THE USER

1st January 1995

Micro90
First Floor
Hamworthy House
New Quay Road
Poole
Dorset



BH15 4AD
ENGLAND



COMPANY LIABILITY
READ CAREFULLY, USAGE OF THIS SOFTWARE MUST DEPEND ON ACCEPTANCE OF 
THESE TERMS

1st January 1995

The Invoice90 for Windows software system has been carefully designed, complied and 
checked for technical accuracy. Micro90 accept no liability for inaccuracies or errors. 
Comments or correspondence regarding the Invoice90 for windows software system and 
help files should be addressed to :

Micro90
First Floor
Hamworthy House
New Quay Road
Poole 
Dorset
BH15 4AD
ENGLAND

MICRO90 ACCEPT NO LIABILITY FOR ANY DATA LOSS,CLAIMS,FINES OR ANY OTHER KIND OF 
PENALTY INCURRED BY THE USER



Ordering Invoice90

1st July 1995

 If you wish to use Invoice90, you must register the software . This will entitle you to 
technical support.

To Order simply print this form, fill in the details and send with payment to the address 
below.

COST = Pounds Sterling    £24.99 (+ £1.50 P&P)    + VAT. Total = £31.13 ( Made payable to 
Micro90 ).    (Micro90 reserve the right to change this price without notification)

More details on Payments

___________________________________________________________________________

Name _______________________________________________________
Company _______________________________________________________
Address _______________________________________________________

_______________________________________________________
_______________________________________________________
_______________________________________________________
_______________________________________________________

Country _______________________________________________________
Email _______________________________________________________
Tel _______________________________________________________
Fax _______________________________________________________
Line of    business _________________________ VAT No. ______________________

 The latest version of Invoice90 for Windows will be despatched within 21 day of receipt of 
order/payment.

 Your details will be stored by Micro90 to be used to inform you of Micro90 products. Please
tick here _____ if you do not wish your details to be disclosed to a third party.

SEND TO:

Micro90 (Shareware Registration)
First Floor
Hamworthy House
New Quay Road
Poole
Dorset
BH15 4AD  
ENGLAND.



Payment 

If you live outside the UK, you may obtain a Foreign Draft or International Money Order from 
either your Bank or Postoffice made payable to Micro90.

If you live within the UK, simply provide a cheque or postal order made payable to Micro90.

 All Payments must be made in Pounds Sterling

 IF YOU ARE A VAT REGISTERED COMPANY WITHIN THE EC (NOT UK) AND YOU PROVIDE
US WITH A VALID VAT NUMBER NO VAT WILL BE CHARGED.



The RNLI are a charitable organization based in Poole ,Dorset ,England . They operate 
Lifeboats around the coast line of Great Britain , Crewed by mostly voluntary individuals




